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  1 About UC-One for Desktop  
 

UC-One provides a robust and user-friendly UCaaS application installed on the user’s 
desktop (Windows & MAC) that is integrated with the Hosted PBX service. The 
application offers numerous unified communication features under the user’s profile on 
the Evolve IP platform. 

UC-One for Desktop is a native Windows and Macintosh client for Unified 
Communications, providing the following communication features: 

 Instant Messaging and Presence 

 Voice Calling (VoIP) 

 Voice Calling (Desk phone) 

 Voice Sharing (Guest Client) 

 Video Calling 

 Desktop Sharing 

 Call Settings 

 Hub microapp integration 
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2 Getting Started 
 

 

This section contains the essential information for getting started with UC-One. 
 

2.1 Installation 

Your group Administrator provides the download of the installer from the Evolve IP support site 

Windows 

 Double-click the installer executable and follow the installation instructions. 

 Launch UC-One. 

OS X 

 Double-click the disk image. 

 Copy the application into the Applications folder. 

 Launch UC-One. 
 

2.2 Log In 

The Login screen displays the following: 

 User ID – Editable combination box that saves all entered usernames for easy selection later. 
This field is empty at first start up & requires Application Username. 

 Password – This field is password masking. To obtain Username and Password please contact 
your administrator 

 Remember Password – Unchecked by default 

 Sign in automatically – Unchecked by default and disabled when Remember password is not 
checked. This check box applies when the client is started 

 Help Link – Directs you to Application User Guide information 

 Preferences link – Preferences can be accessed directly from the login window 
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2.3 Main Window 

The contact list is the Main window of the application. When you start UC-One for the first 
time, your Contacts list is empty. Use the search field to find people and add them to your 
Contacts list. Contacts can also be added manually by clicking the Add button. Client can be 
set also be set up to be always using the Main window menu option. The left pane call 
settings icon and menus are visible 

The following Contact List Management features are provided: 
1) Add, edit, and remove contacts or groups. 

2) Filter the contact list by typing a search term into the Search and Dial field. 

 
Additionally, a number of right-click options are available for both groups and contacts. 

Figure 1 Tabbed Main Window 
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2.4 My Information 

 Click the Presence Icon to update your status or location and enter free text. 

 Double-click the avatar to upload a picture or use a right-click menu. 
 

Presence 

Each contact type has its own icon listed in the following table. Presence subscription means 
that you both show your presence information to each other. 

 

Icon What it means 

 

 The green presence icon indicates that the user is online and ready for communication. 

 

 
The yellow presence icon indicates that the user is online but has been idle or away from their 
computer for more than ten minutes. 

 

 The red presence icon indicates that the user is busy and does not want to be disturbed. 

 

 
The grey presence icon indicates that the user is offline and the only available contact method 
is calling or leaving a chat message. 

 

 
This icon indicates that the contact is busy on a call. This is an automated presence status. 

 

 
This icon indicates that the contact is busy in a meeting. This is an automated presence status. 
The Busy – In Call status overrides the Busy – In Meeting status so this one is only seen if there 
is a meeting but no call. 

 
UC-One can automatically update your presence to the following: 

 Busy – In Call 

 Busy – In Meeting (Windows only) 

 Available (desk phone) 

 Available (mobile) 

 Offline and busy in call 
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2.5 Location 

Your location is automatically determined by your public IP address; however, you can 
manually set the text to appear for your location and time zone using the location dialog box. 

 

2.6 UC One Window 

After starting communication with one or more contacts, a UC-One window is displayed. 
From this window, you can perform the following actions: 

 Escalate a chat to include audio, video, and desktop sharing 

 End an audio or video call 

 Open the dial pad 

 Mute your microphone 

 Adjust your speaker volume 

 Place a call on hold 

 Transfer a call 

If you are using several monitors, the application opens the UC-One window as well as 
notifications on the same monitor as the Main window. 

UC-One limits the number of active communications to spare resources. The limit is 20 active 
communications on Windows and on OS X. If the maximum is reached, the main window’s 
top section warns user with the following message: “The maximum amount of 
communication windows has been reached. Please close some to open new ones.” 

If an incoming call is answered while this warning is shown, the client closes the chat session 
that has the longest time since its last activity. 

 

2.7 Start Chat 

Start a chat using one of the following methods: 

 Double-click a contact from the Contacts list or search results. 

 Left-click one or more contacts from the Contacts list or search results and click the Chat 
button. 

 Right-click one or more contacts from the Contacts list or search results and click the 
Chat button. 

 On the UC-One History list, double-click a chat entry. 

 In a UC-One window, click the Chat button. 

 In a one-to-one chat, transfer files by clicking the Send File button in the UC-One window 
or use the drag-and-drop method so that they are moved to the UC-One window. 

2.8 Send File 

In a one-to-one chat, transfer files by clicking the Send File button in the UC-One window or 
use the “drag and drop” method so that they are moved to the UC-One window. 
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NOTE: If dialing a phone number that requires additional dual-tone multi- 
frequency (DTMF) tones (for example, a conference bridge), you can type the 
numbers on your keyboard while the UC-One window has focus or open the dial 
pad in the UC-One window. 

2.9 Make Audio or Video Call 

Make an audio or video call using one of the following methods: 

 Left-click one or more contacts from the Contacts list or search results and click the Call, 
Call from Phone, or Video button. 

 Right-click one or more contacts from the Contacts list or search results and click the Call, 
Call from Phone, or Video. 

 Enter a phone number in the Search and Dial field. 

− Press ENTER to start a VoIP call. 

− Click the Call, Call from Phone, or Video button. 

 Open the dial pad, enter a phone number, and then click the Call, Call from Phone, or 
Video button. 

 On the UC-One History list, double-click a call entry. 

 In the UC-One window, click the Call, Call from Phone, or Video button. 

 When viewing a contact’s profile, click the Call, Call from Phone, or Video button. 
 

 

2.10 Share Your Application or Desktop 

Share your desktop by following these steps: 

1) Click the Start Sharing button in the top of the UC-One window (if share panel is not 
visible). The Share button is visible by default in My Room also 

2) Select the application to share or the entire screen of a particular display and click the 
Start Sharing button. 

 

2.11 Active UC-One Communications 

Active communications appear at the top of the Contacts list in the main window. This area 
provides an easy view to see the people with whom you are communicating. The following is also 
available in this area: 

 Double-click an active communication item to bring this UC-One window to focus if the 
call window is separately shown. If the call window is integrated, you can use a menu 
option to show it separately. 

 See who has sent you a chat message, but only after you accept the chat session. Before 
the chat session is established, the chat items are not visible in active communications but 
a history badge is visible. 

 End a call 

 Mute the microphone 

 Place a call on hold. 
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 Merge two calls or transfer by dragging and dropping calls onto each other. 

 Transfer a call. 

 Make conference calls. 

 Park and retrieve calls. 

 Conference. 

 Call transfer. 

 Call park 
 

2.12 My Room 

My Room is an always available and permanent room you can use to chat with anyone that joins. 

With a conference bridge assigned to your profile in Preferences → Credentials, then in your room, you 
and your attendees can click the Call button to have UC-One automatically dial in to the conference and 
enter the appropriate entry codes. Note, with automation enabled,  you cannot edit these conference 
ID details. 

If a conference bridge is not specified, you cannot initiate a call in your room, you can however initiate 
an N-way call in your room. UC-One dials out to all participants and takes everyone off hold after the 
last attendee answers. 

You can invite others to your room by dragging and dropping them from the Contacts list into the My 
Room tab. You can also use the right-click menu on the My Room icon in the top-right corner of the 
Main window or the My Room information area to copy an invitation link for guest users (people 
without UC-One) They can then click the link and join the meeting through an app. Guest users must 
be separately accepted for each session. 

Contacts join your room by right-clicking your name on their Contact list and selecting Join Room or 
by an invitation you sent. 

Email My Room Invitation menu results in working links for guest users only. UC-One users are 
recommended to use Copy My Room Invitation links; however, the links may not work in all 
applications as they were originally intended for Outlook. 
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2.13 Select Audio Devices 

If you have multiple audio devices available for your microphone or speakers, select the preferred 
audio device before starting a call. If “Use default” has been selected, then UC-One uses the 
default device set in the operating system preferences. 

Windows 

 Click the UC-One logo in the main window title bar. 

 Select Preferences. 

 Select Audio. 

 Set a playback device (speakers). 

 Set a recording device (microphone). 

 Click OK. 

For Windows, if “Default Communication Device” is defined, it is selected over the “Default 
Device”. If you are using headsets, you can also select a separate device than the headset for 
alerting incoming calls. 

 
OS X 

1) Select UC-One from the main menu. 

2) Select Preferences. 

3) Select Audio. 

4) Set a playback device (speakers). 

5) Set a recording device (microphone). 

Click OK. 

Note that on OS X it is recommended to disable “Use ambient noise reduction” in System 
Preferences toreduce echo. 
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3 Contact Management 
 

3.1 General 

Contacts are the people with whom you communicate and, in most cases, you see their 
presence and share your presence with them. There are three types of contacts. 

 Contacts – Actual people with whom you communicate 

 Favorites – Optional setting for contacts with whom you have the most communications 
 Conferences – Audio or video conference bridges that you use to communicate with 

others 
 Groups – Containers of contacts and/or conferences 

3.2 Add 

When you sign in for the first time, there are no contacts on your contact list. Add a new contact 
at any time by using the Search and Dial window. Type in the first or last name. In the 
Directory, right click on the result that you want to add and choose ‘Add to Contacts’ 

The newly added contact appears on your contact list. 

You can add this contact to your favorites by right-clicking the name and choosing ‘Set as Favorite’ 

Add a conference contact by clicking the same button you did for Add Contact and choosing 
the Add Conference menu option. A conference contact is a special contact used for 
conference bridges to avoid remembering PIN codes and conference number, for example, 
recurring conferences. Just create a contact for the weekly conference, add a conference bridge 
number and PIN, and join the conference just by right-clicking the contact or choosing it and 
clicking the Call button. 

Choose the Add Group menu option to add a new group to the contact list. Move contacts in or out of 
groups as desired.
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3.3 Edit 

Edit a contact by selecting the contact first. After you select the contact, right-click anywhere in the 
area of the selected contact and a menu of options appears. This base principle is the same for 
normal contacts, conference contacts, and groups. 

 Unsubscribe removes the presence relationship between you and that contact. This means 
you do not see the contact’s presence information and your contact does not see yours. To 
re-establish the presence relationship, select Subscribe. An unsubscribed contact remains on 
the contact list and is always shown without an icon. Any contact that is not presence-enabled 
is shown in the same way. 

 Remove removes the contact from your contact list. 

 View Profile opens the Contact Information dialog box where you can add, edit, or remove 
information. This works for both normal and conference contacts. 

 For groups, choose the Edit menu option to rename a group. 
 

3.4 Filters 

You can filter contacts in two ways: 

 Use the filter field to search by contact name. The contact list is filtered in real time as 
you type. 

 Alternatively, use the filter icons in the top bar to display only specific types of contacts 
such as favorites, conference contacts, or online contacts. 

Favorites: 

 When you make a contact your favorite, the favorite group shows on top of the contact 
list and cannot be hidden. 

 When you delete all your favorite contacts, the favorite group does not show anywhere. 

 When you have even one favorite marked, you see the group. 



PAGE 14 OF 44 

 

 

 

4 Presence 
 

 

For each contact you have subscribed to, you can see their presence. Similarly, your contacts can 
see your presence on their contact list. 

Presence means that your contacts are able to see whether you are available to communicate, for 
example, “I’m busy” or “I’m available”. 

If you see an error message at the top of the Main window “CHAT Unavailable”, it means 
that the CHAT connectivity has been lost for chat and presence; however, you can still 
make calls. You should contact your administrator 

Have the Outlook calendar automatically change your presence to Busy – In Meeting by 
enabling this in the Preferences → General tab (native desktop only). 
The presence update is only triggered by appointments and meetings that are in the Show 
me as busy state. 

The CHAT address of a contact cannot be changed. Instead, you must delete the old 
contact and create a new one. 

Location in presence is done based on the IP address that the machine is using. The 
IP address is mapped to a physical location. Change the location manually by clicking 
the avatar and then the location icon to go to the manual location and change the 
view. 

 

Icon What it means 

 

 
The green presence icon indicates that the user is online and ready for communication. 

 

 
The yellow presence icon indicates that the user is online but has been idle or away from their 
computer for more than ten minutes. 

 

 
The grey presence icon indicates that the user is offline and the only available contact method is 
calling or chatting. 

 

 

The question mark indicates that a subscription is pending and the contact has not yet approved 
sharing their presence. 

 

 

This icon indicates that the contact is busy due to a call. This is an automated presence status. 

 

 

This icon indicates that the contact is busy due to a meeting. This is an automated presence status. 
The Busy – In Call status overrides the Busy – In Meeting status so this one is only seen if there is a 
meeting but no call. 
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  5 Chat  

5.1 Chat View 

When you initiate a chat, the Chat tab inside the Main window opens. Chatting with a contact is 
possible only when you are both online. If your contact initiates a chat, you see a pop-up notification 
in the bottom right-hand corner of the screen. If you close the Chat tab and open it again, sent chat 
messages are shown in the tab as chat history. When enabled by your service provider, a typing 
notification is also shown. 

When the chat opens, you see the contact’s information at the top of the screen.. 

At the top of the message area, there are four links: Yesterday, Last week, Last month, and All 
history. From these links, you can load history from your local storage and different time frames. You 
can delete the history using the drop-down menu. 

In the text field, you can add a smiley emoticon. Smiley emoticons can also be added by manually 
entering the corresponding characters that represent that particular emoticon. You can send text by 
pressing ENTER. 

Emojis are also supported and are rendered as ordinary emoticons when received. To enter a 

line break in the text field, you can use the following key commands: 

 CTRL+ENTER (COMMAND+ENTER on Mac) 

 SHIFT+ENTER 

 ALT+ENTER 

Use either one of the short commands, CTRL+C or CTRL+V, or right-click the selection for a menu 
to copy or paste the text to or from the Chat tab. 

All sent and received chats are stored locally in the chat history and an optional message history feature 
provides multi-device enhancements so that messages sent or received in other own devices would 
also beshown. 

 

5.2 File Transfer 

File transfer functionality is accessible only through the Chat window. 

1) To open the File Selection dialog box, click the Send File button on top of the text field. 

2) Select the file to be sent from the dialog, and then press Open. You can also drag and drop a file 
into the Chat window. 

3) Once the file offer is issued and during its transfer, you can cancel the transfer (at any time) by 
pressing Cancel. 

4) Accept an incoming file transfer by pressing the Accept button. 

5) Reject the file transfer offer by pressing the Decline button. 

After the file transfer has completed, the received files can be opened or viewed in the file manager by 
using the Click to open and Show in folder links. 
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5.3 Group Chat 

Start a group chat by “multi-selecting” and right-clicking the main window contact list or 
through the Conference menu in the UC-One window. More people can be added later to 
the chat by drag-and-drop or by using the Conference menu. Only the owner can add more 
participants. 

A group chat works the same way as a one-to-one chat. All messages from anyone are sent to 
everyone else. All contacts need to be online to be able to participate in a group chat. You 
cannot invite an offline contact or a contact that is not on a device that supports group chat. 
This does not affect the group chat in any way. 

A group chat history is saved and is available to view later in the Messages tab of the main 
window. 

In the text field, the contacts’ names appear in different colors to easily distinguish between 
who is writing. 

Only the newest chat room messages are stored on the server. One-to-one chat messages 
are only saved locally. 

Deleting a chat room is not supported. 

Chat rooms can be moderated by the owner. Use the right-click menu options to remove a 
participant from your chat room. If needed, the removed participant can join later. The 
removal also applies to desktop share sessions. 

Typing notifications are not supported in group chats 
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6 Audio and Video Calls 
 

The following table describes additional UC-One window icons and explains what you can do 
with them, for voice and video calls. 

 

Icon What you can do 
 

 
Enter additional digits using the dial pad at any time during the call (for example, to 
insert a conference number). The dial pad is not movable. 

 

 

 
Mute your microphone by clicking the mute icon. 

 

 

 
Adjust the volume bar to adjust the volume. Dragging it all the way to the left mutes 
your speakers. 

 

 
Use this icon to access the Call Options menu. In the Call Options menu, you can find 
different actions to use for a call depending on your settings and your service provider. 

 
In the Options menu, there are the following options: 

 Transfer a call to a third party (native desktop only). 

 Put the call on hold. Note that if you hold the call, the other party cannot “unhold”. 
This freezes a video call to the last frame of the video feed. In both voice and video 
calls, this is communicated to all parties by a notification appearing in the middle of the 
screen. 

 Hide or show your ownvideo. 

 Add participants to the call (native desktop only). 

 
When establishing a call to a contact, you can choose several ways to call. Select the contact 
you wish to call and press the Call icon. This calls the default number. If you right- click on 
the contact you wish to call, you can choose the number to call from a right-click menu. 
There can be several phone numbers available in the menu. The work phone is the default 
and top most number is followed by mobile and other numbers. This also applies to the 
transfer and conference windows. However, in certain cases the transfer/conference default 
number can differ from other call options in other menus. 
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6.1 Call From Computer 

Select a contact from your contact list to start communication and click the desired 
communication button. Type a phone number in the Search and Dial field at the top of 
UC-One window (search or communicate) to communicate with someone who is not on 
your contact list. 

6.2 Call From Phone 
The second option to communicate in the row of communication buttons is the Call from 
Phone. When you click this button, the desk phone instantly starts ringing and the call is 
established from your desk phone. This depends on your service provider configuration as 
other devices may also ring. 

When your service provider is configured to also initiate a call from computer (SIP call) to the 
same machine that initiated a call from phone, that incoming (SIP) call will be accepted and will 
alert if it does not have the same identity as the call from phone. 

For remote calls initiated using UC-One, you can also have mid-call controls such as 
hold/resume, transfer, and add participant. 

Automatic Busy – In Call presence also works with the Call from Phone feature. 

Depending on your service provider settings, it is also possible to control calls initiated 
without UC-One in the Active UC-One view. The same mid-call controls are also available in 
this case. In case of an incoming call, the actual answering action must happen with the other 
device. 

6.3 Answer Call 

When someone is calling you, you see a pop-up notification on your screen. You can choose to 
answer, silence the incoming call, and then open a chat session with the caller, reject the call, or 
silence the incoming call by closing the pop-up notification window. If you silence the call, the 
ringtone is silenced but the caller does not see anything on their end. You can answer or reject 
the call after silencing it only if you have chosen the chat option. If you close the incoming call 
pop-up notification to silence an incoming call, then you do not have an option to answer or 
reject it any more. When choosing the chat option, chat is only enabled after the call has been 
answered or rejected. 

If you reject the call, it causes the line to sound busy at the caller’s end and they know that you 
rejected the call. 

When someone is calling you with a video, you see the same pop-up notification; however, 
the options are answer with video, answer as voice only, silence and chat, reject, or silence 
(by closing the pop-up window). If you decide to answer as voice only, the call is voice only. 

6.4 Missed Call or Communication 
When you have one or more missed calls or other types of communications, there is a 
notification on the left-hand side of the navigation pane in the Main window. Clicking the 
icon takes you to the missed communication in the UC-One History view. 
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6.5 Full Screen in Video Call 

Full screen mode can be activated by clicking the Full Screen button or by double-clicking 
anywhere on a video. 

Exiting full screen mode is done by pressing the Esc key (on both Windows and OS X) or by 
double-clicking the window. Exiting full screen makes the video call go back to its original state 
(even if there was resizing of the window previously before going full screen). 

In a full-size window, you can see a similar Options menu at the top. It has the same 
functionality as it does in the normal view. When you move the mouse, the top bar and lower 
communication buttons appear on top of the video. 

 
6.6 Conferencing in UC-One 

You can have up to 30 participants in a call, either in a My Room or in an ad hoc 
multiparty call (native desktop only). Add more participants by dragging and dropping 
them on to the UC-One window or by selecting the Conference menu item via the UC-
One window menu button. By choosing the menu item, you can also add participants with 
just a telephone number. 

In contrast to using My Room, which uses your permanent chat and collaboration rooms 
and conference bridge, you can start ad hoc multiparty sessions by either selecting 
multiple contacts on the contact list and starting a chat, by calling them, or by expanding a 
one-to-one session into a multiparty session by dragging and dropping a contact into the 
UC-One window. In an ad hoc session, the room used is a temporary one that is deleted 
once the session ends (that is, when the last participant leaves). 

NOTE: Conferencing multiple calls requires every person to be ACTIVE in your contacts list. 
UC-One dials out to all participants and takes everyone off hold after the last attendee 
answers. 

 
6.7 Call Waiting 

You can have one active call at any one time if you receive a new incoming call and accept 
it. The existing call is put on hold and you can change between these two calls by using the 
Hold and Unhold buttons. 

 
6.8 Call Transfer 

Blind call transfer is available in the UC-One window; choose the Transfer Call menu item 
to transfer the call to someone else (native desktop only). Attended call transfer is also 
available in the same window, first call someone to check if the called party can take the 
incoming call and then transfer the incoming call to the desired called party. 
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6.9 Visual Voice Mail (Preview) & Message Waiting Indication 

Depending on your service provider settings, you can have either Visual Voice Mail 
(preview feature) or Message Waiting Indication (MWI) view in your client. 

The MWI service allows you to receive a notification for a waiting voice mail or video mail. 
By clicking on the message icon in the upper part of the Main window, UC-One calls the 
predefined mailbox number to allow the user to listen to the voice mail or view the video 
mail. With this view, you only have two history tabs: one for calls and another for chat. 

It is also possible to call voice mail from the dialer by long pressing the “1” icon in the 
dialer. 

When visual voice mail is enabled, a third tab is available, showing visual voice mails. Click 
on individual mails to listen to them. Video mail is supported as a preview feature if 
enabled by your service provider. 

Missed calls are indicated by an icon in the Main window. Missed video and audio calls 
are indicated with a different icon. Note that the MWI icon is in the same place when it 
indicates a new voice mail. 

Visual voice mail is also supported when enabled by your service provider. You can see 
all voice mails in a list and play them inside the Main window. 

The following settings are needed on CommPilot portal to have visual voice mail: 

 Voice messaging enabled 

 “When message arrives, use unified messaging” option enabled 

 “Use Phone Message Waiting Indicator” option enabled 

 
6.10 Call Park and Retrieve 

Call Park is particularly suited for shared environments where one person can answer 
the call, park it, do something else for a while and continue the call from another device 
or let somebody else continue the call (supported on native desktop only). 

Transfer an ongoing VoIP call to a Call Park server and then retrieve it when 
needed. An ongoing call can be parked against your own number or another 
number (an extension). Call Retrieval works in the same way, the parked call can be 
retrieved from your own number (an extension) or another number (an extension) to 
provide flexibility for who is picking up the parked call. 

A parked call is visible on your desktop in the Active UC-One area so that you can 
easily retrieve it, but only for the duration of the Call Park announcement. 

After the announcement is over, the parked call disappears from the Active 
Communications area (since the triggering call is disconnected). After the call 
disappears from the Active Communications area, the user must remember the 
extension to which the call has been parked to retrieve it using the Main window 
menu (or feature access code), unless the call was parked to the one’s “own” 
extension. If the call is not retrieved after a certain time, then the server calls the 

parking user. 
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6.11 Call Pull 

Call Pull allows you to pull an ongoing call from one of your devices to another one 
where the Call Pull feature is used (native desktop only). 

6.12 Call Recording Controls 

You can use call recording controls in this release (native desktop only). Depending 
on your service provider’s configuration, call recording can be initiated when a call 
starts or dynamically during a call (and start, stop, pause controls may be available). 
Additionally, there is an audio indication that call recording is ongoing as well as a 
visual indication. 

Feature Access Codes can also be used to control call recording when enabled in 
the configuration. 

Recorded calls are accessed outside of UC-One; that is, you cannot view them using 
the client. 

Depending on your service settings, call recording behavior is one of the following (this 
cannot be controlled in the client but in the self-provisioning portal): 

 Always – recording indication (icon) in the UC-One window as well as the 

 Active UC-One user interface (UI). 

 Always with pause/resume – recording indication (icon) in the UC-One window 
as well as in the Active UC-One UI (only pause/resume menus available). 

 On demand – recording indication (icon) in the UC-One window as well as the 
Active UC-One UI (no stop menu available, only start and pause/resume). After a 
call is established, call recording starts on the server. If the user presses the Start 
Recording button during the call, the call recording is stored and the server 
keeps the recording of the whole call regardless of when the recording was 
started (except for pauses). Otherwise, if no start recording is initiated from the 
user, the call recording is deleted from theserver. 

 On demand with user-initiated start – recording indication (icon) in the UC-One 
window as well as the Active UC-One UI (menu options available for start, stop, 
and pause). Call recording can be initiated at any time and several times during 
a call. There are separate call recordings for each call recording startup. 

 Never – no indicators or menu options present. 

NOTE: Pause/resume audio indication depends on your service provider 
settings. It is recommended to log back in after changing the call recording 
mode in the self- provisioning portal. 
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6.13 Moderator Controls 
You can control the functionality available to participants if you are the owner of the 
session in My Room. You can do the following: 

 Dismiss one or more participants. This ends all sessions (group chat, audio, video, and 
share) when the participant is using UC-One for Desktop. 

 Mute one or more participants. 

 Lock or unlock the room (when locked, no additional participants can join). 

 See active talker  indication. 

 See full audio participant list. 

 To invoke the features, you can use the right-click menus or you can click on the 
moderator control icons of a participant. 

Note that most features are not available via icons. To dismiss or mute all participants or 
lock the room, use the right-click menus available for your own icon at the top of the 
participant list. 

If you are not the owner, you can only see the CHAT (chat) participant list or the full 
participant list along with mobile participants (depending on your service provider 
settings). 

6.14 Headset Support 
You can control incoming and ongoing calls from a compatible headset. The feature set 
supported is answer/hang up as well as mute/unmute. Volume control operations are not 
reflected in the UC-One UI. Here is a list of tested and supported headsets. Many 
headsets not included in the list below are compatible with UC-One. We recommend 
that you test one headset before a bulk purchase. Headsets typically use an add-in of 
some kind to communicate with the rest of the client while calls are made. Currently, 
installed add-ins are visible in the Preferences Add-ins tab. 

 Plantronics Voyager Edge UC 

 Plantronics Savi 700 series 

 Plantronics Blackwire C3xx, C4xx, C5xx, and C7xx 

 Plantronics Calisto 620 

 Plantronics Voyager Legend UC 

 Logitech H570e Mono 

 Logitech BCC950 

 Logitech Conference Cam Connect 

 Jabra Biz 2300/2400 

 Jabra Speak 510 

 Jabra Pro 930 (wireless) 

 Sennheiser SC 230/260 

 Sennheiser SP 20 

 Sennheiser MB Pro1UC 
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6.15 Call Center Agent Login 
Call Center Agents now have the availability to log in to your call center queues if you are 
a call center agent (native desktop only). 

You can do the following: 

 View your call queues. 

 Join your call queues. 

 Set the Automatic Call Distribution (ACD) status so that you get incoming call center calls. 
However, this is dependent on your license settings. 

With suitable ACD status such as “Available”, incoming calls to the queue are routed to your 
client. With “Unavailable” ACD status, the Do Not Disturb (DND) state can also be selected 
or “Personal Call”. Each ACD status indicates with text if you are to receive incoming call 
center calls. 

 
6.16 Remote Control Event Package 

For users with 2 applications installed on their desktop, Remote Control allows you to 
answer a call or put it on hold from a receptionist or call center client while the results are 
seen in your UC-One desktop client. Answer and hold/resume buttons are visible in 
Receptionist/thin client to perform call management operations. 

 
6.17 Auto Answer 

For auto-answering incoming SIP calls for call center scenarios. The incoming call notification 
is identical to the usual incming call notification. 
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7 Application or Desktop Share 
 

 

To share your desktop or individual application: 

1) In the UC-One tab, click the Start Share button. This does not yet start the 
“share”. 

2) Select either to share your entire display or one of your open applications and click 
Start Sharing. 
The share widget appears to let you control share settings such as Preview that 
shows you what participants are seeing and Pause that pauses sharing. 

3) To stop sharing, click the Stop icon. While sharing, all other communications 
mechanisms are also available except for video calling and file transfer. 
Participants cannot hide a share without closing the UC-One window. 

 
Desktop sharing works the same way in both My Room and the ad hoc sessions. For 
participants without UC-One, use the separate Desktop Share Invitation link available by 
right-clicking the My Room button.If you are using dual monitors, the client should share 
the primary monitor. If you have been sharing different monitors, make sure that you 
want to share the primary monitor. You can check the primary monitor in the operating 
system settings. 

If you are using dual monitors, you can choose which monitor to share. You can 
check the primary monitor in the operating system settings. 

 
You can also remove desktop share participants. They are also removed from the 
group chat at the same time. If needed, the removed participants can join later. 

 
You can also remove desktop share participants. They are also removed from the group 
chat at the same time. If needed, the removed participants can join later. 

 
Participants do not have to take any action to accept share invitation. It is 
automatically accepted. The same also applies to share passing. That is, the owner 
does not have to take action for participant to start sharing. 
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8 My Room 
 

My Room is started by clicking on the My Room icon on the left-hand side of the navigation pane. 
My Room is started automatically using your permanent chat room. Add more participants by 
dragging and dropping them into the UC-One window or the Conference menu, or they can join 
your room by right-clicking your name on their contact list and choosing the Join room menu 
option. Once people have joined the chat room, they can click on the Call button of that window 
to join the conference. The room owner can also share their desktop. 

Only the owner of the room can share the desktop or add more participants. This applies to both 
My Room and any ad hoc sessions. 

1) To see a Context menu, right-click the My Room icon on the left-hand side of the navigation 
pane. 

2) To modify credentials and conference bridge information, select Configure to go to the 
preferences. Your credentials are automatically input for you and cannot be edited. 

3) Select Copy invitation to copy an invitation link to the operating system clipboard. Paste this 
link, for instance, to meeting invitation e-mails to allow UC-One participants to join the 
conference in one click from, for example, Outlook or Office applications. 

The link has two parts, one for UC-One users, and another one for users with some other 
client. The invitation also contains a link to the desktop sharing session as well as a dial-in 
number and PIN for users who do not have UC-One. The desktop share link allows anyone to 
join a desktop share session from a standard web browser. In addition, the UC-One group 
chat session is supported with the web collaboration session. 

The My Room icon also has a tooltip indicating the conference bridge details of your My Room. 
 
 

UC-One Connect also supports initiation of Webex Meetings rooms instead of a My Room session. If you 
have a Webex personal room (sold separately), you can set your default method of collaboration to Webex 
Meetings by going to the Options > Services window. Change the radio dial to Webex Personal Room and 
enter the URL for your Webex Meetings personal room. 
When this change has been made, you will notice that the My Room icon changes to the icon for Webex 
Meetings.
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9 Guest Client 
 

 

UC-One Connect enables added functionality in MY ROOM (Collaboration) to interact with “Guests” 
outside of the organization. 

 
UC-One Users have the ability to generate separate invitations for guest users using My Room right- 
click menu items. The MY ROOM invitations are generated using separate menu items and is 
intended for UC-One users. 

The Guest client supports the following features: 

• Audio calling for external participants. 

• Ability for Guest users to share their applications and desktop. 

• Join a multiuser chat session. 

• View the participants who joined the session. 

• View the screen share between all participants. 

• Leave the collaboration session. 

PLEASE NOTE: 

***The Guest Client integrates with Meet app only*** 
 

 
 

9.1 My Room to Guest Room Interaction 

 
This section provides more hands-on information about guest client usage. 

 
1) Right-click on the My Room icon to copy the guest join link and/or send it to a 
guest via E-Mail. 

 

Figure 3: Copy Guest Join Link Menu Option 
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2) The guest can open the link . They will be prompted enter first and last name, then 
to install the Meet app (if not previously installed)

 

 

3) The guest is allowed into your room and can now participate in multi-user chat with 
other participants in the room (as shown in the following figure). However, guest clients 
do not have private chat possibility and they can see the chat history of messages that 
occurred after they joined the session. 
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9.2 MY ROOM Administrative Controls 

The primary UC-One user has complete administrative control over the external “Guests” joining 
the conference to the UC-One user’s MY ROOM. 
1) Participant Control from MY ROOM: 

 Mute and Unmute all Guests 
 Dismiss All Guests (Dismisses the guest’s out of the conference) 

 

 
 

2) Individual Guest Control: 
 Mute/Un-Mute an Individual Guest 
 Dismiss a Guest from Conference 
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10 Search 
 

 

UC-One supports a search of the enterprise directory. This takes place in the same 
search field that is used for both a local and presence-enabled contact list search. 

UC-One automatically searches the local contacts and presence-enabled contact list in 
addition to the enterprise directory at the same time. As soon as there are results from 
the enterprise directory, these results are shown on a separate list in the main window. 
Additionally, there may be other search result groups from other search sources such as 
Outlook. 

Search results are displayed differently depending on the results of the contact list and 
directory search: 

 If Outlook search are enabled, there are more result groups. 

 If there are no results for a certain search source (local contacts, Outlook, or 
telephony directory) that group is different in the user interface (UI). 

The enterprise directory searches for the first name and last name. By default, it waits for 
1.5 seconds before it sends the search request to the server to minimize unnecessary 
load on the server. 

Typically when adding a contact using directory search results, there are phone numbers 
and first names in addition to last names available. In addition, the Extensible Messaging 
and Presence Protocol (CHAT) address and other fields are imported when found to 
allow presence and chat. 

Outlook integration (search and calendar integration) on Windows requires one of the 
following versions installed on the desktop: 

 Outlook 2007 

 Outlook 2010 

 Outlook 2013 

 Outlook 2016 

 O365 

Outlook search also works when several Outlook accounts are in use, but only one 
account is used at a time (default selected, which can be changed in Outlook). 
Additionally, other related considerations are as follows: 

 The client searches for contacts and calendar entries in the default Outlook account. 
The account is set to the default via File → Info (left pane) → Account Settings → 
Account Settings → Data Files. Select an account and mark it as “Set as Default”. 
After making this change, sign out and sign back in to the client and it now searches 
that account for contacts and calendar entries. 

 The client searches the Outlook contacts only on the local machine (that is, the 
Outlook Address Book). There is no Exchange server lookup performed. In addition, 
all directories in Outlook are searched for contacts, even deleted folders. The 
Contacts directory can also have multiple levels of subfolders. 
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Every minute, UC-One reads Outlook appointments. If there is an appointment running 
at the current time, the presence is shown as Busy – In Meeting. Overlapping 
appointments are also handled. Following are some examples of UC-One operation with 
Outlook when time is 9:10 A.M. 

 There is meeting “A” 9 A.M. through 10 A.M. Presence is shown as Busy – In 
Meeting. 

 Presence is explicitly changed to Available at 9:15 A.M. Presence is shown as 
Available. 

 In the next minute, UC-One again reads the appointments and sees that “A” 
meeting is running; however, the presence was already explicitly marked as Available 
and presence is not shown as Busy – In Meeting but Available. 

 There is an overlapping meeting “B” 9:30 A.M. through 10:30 A.M. Presence is 
shown as Busy – In Meeting when the time is 9:30 A.M. 

When deleting a meeting that is currently ongoing in Outlook, the presence status 
remains as Busy – In Meeting until the next time Outlook appointments are checked 
(once every minute) and after that, presence is shown as Available. This change may be 
instantaneous or it may take a minute depending on how close the timer is to being 
triggered. 

The presence update is only triggered by appointments and meetings that are either 
accepted by the user or made by them. All-day meetings do not trigger a presence 
change to Busy – In Meeting. 
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11 Full Enterprise Directory 
 

 

UC-One allows for the browsing of an entire telephony enterprise directory. 

To view the telephony enterprise directory, click the Directory button on the left-hand 
side of the navigation pane. 
 

12 Hub 

Hub allows you to integrate pre-designated micro-apps – simpler versions of 
applications like Outlook, Google Suite and others. Hub enables contextual 
information next to your communications. When Contact A calls or chats you, other 
recent items such as emails and calendar events from Contact A are displayed. 

12.1 Enable Hub  

 Hub will be made available according to your system administrator’s instructions during 
implementation. When Hub is available, you can enable it by clicking on the Options icon 
(bottom left) and choosing “Services” from the pull down menu at the top. Move the slide 
bar to the right to enable Hub. 

12.2 Hub Settings 

Once Hub is enabled, you will need to activate individual micro-apps. Start by clicking on 
the Hub Settings link. This will bring you to the “App Store” 

 

Expand each section to display the available micro-apps. As you activate each one, you will 
be asked to provide your credentials for the application. Once entered, Hub builds 
connections to your native applications. 

  



PAGE 32 OF 44 

 

 

 

12.3 Using Hub 

Now that Hub is enabled, you will be able to see contextual information from your 
contacts. You can also use the micro-app features to perform functions from within 
UC-One Connect. For example, you can filter emails, accept meeting invites and 
more. 

 
 

Click the Hub icon in a chat or on a call to display contextual 
communications. Select from the micro-app icons at the top of the Hub 

panel to see items from each micro-app. Choose the Calendar icon to see shared 
meetings, Email icon for recent emails, etc. For each enabled micro-app, there will 
be an icon to choose in this view. If you have more than five, you can use the slider 
arrow to scroll through each. 
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13 UC-One History 
 

The fourth icon from the top in the Main window on the left-hand side of the 
navigation pane displays your messaging history. History view is divided into one, 
two, or three tabs depending on your service provider settings. Possible tabs are: 

 Calls 

 Chat 

 Visual voice mail 

 
Double-clicking a conversation on the chat tab list opens it in a new window while 
double- clicking a call history item calls that number. Clicking a visual voice mail 
downloads the message so you can play it. 

UC-One saves a call history for placed, received, and missed calls. The call history makes 
it easy for you to redial and call back when you have missed a call or you want to easily 
dial a contact with whom you have recently spoken. 

Chat history for group chats, both in My Room and in instant group chat, are stored 
locally on the desktop client, just like in one-to-one chat, but only for the time the user 
is joined into the session. 

Double-click on a name on the list to call back directly (this calls back the same way you 
previously spoke, for example, if you were in a video call, double-clicking starts a new 
video call). 

To clear the missed chat indicator, you need to open the missed chat. 

The Communication History can be cleared by using the right-click menu from the 
Communication History button on left-pane. The menu provides options to clear “All 
missed”, “Clear missed chats”, and “Clear missed calls” 

 

  14 Click-to-Call (Highlight Text)  
 

UC-One V22.2 includes support for Click-to-Call using highlighted text and global 
keyboard shortcuts. Users can highlight text anywhere in the desktop machine to 
make a call and define the default call type used for making the call using the 
shortcut defined in Preferences. On OS X, you must define the shortcuts on your 
own using the instructions provided in Preferences. The order in which key 
combinations are pressed may be significant in some cases if the operating system 
has reserved some key combinations for other purposes. 
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15 Options 
 

 

Preferences provide access to available settings for UC-One. Follow these steps to 
access Preferences. 

Windows 

1) Click the Gear icon on the lower left of the main window. 

2) Select Preferences. 

OS X 

1) Select UC-One from the main menu. 

2) Select Preferences. 
 

15.1 General 

Language 

Select your language and then press OK or Apply and the change takes effect immediately. 
Note that the number of languages depends on Evolve IP. 

 

Log In 

Enable or disable automatic sign-in when starting the application. 
 

Confirmations 

Usually there is a confirmation pop-up notification each time you remove a contact or call 
history record. By selecting one or all of the check boxes, you disable the confirmations when 
deleting information. Here you can also control whether there always is a pop-up notification 
for publishing location information. Typically, this is shown at login. 
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Depending on your configuration, you can also have confirmations for UC-One API, which is 
used by third-party applications such as Outlook Add-in or compatible headsets. You can 
allow such third-party applications to obtain information from UC-One and enable or disable 
confirmation pop-up notifications when third-party applications request information from UC- 
One. You can also choose default behavior to always reject or accept requests from third- 
party applications. 

 

Logging 

Logging is used for troubleshooting. You may be asked by Evolve IP to turn on logging and 
then send a log file directory. 

 

15.2 Audio / Video 

Output Device (Voice Playback) 

Choose a headset, PC-integrated speakers, or external speakers for audio output. Your 
external playback device is selected by default (if you have one connected). 

Input Device (Voice Recording) 

Choose a headset microphone, PC-integrated microphone, or external microphone for 
voice during calls. Your external recording device is selected by default (if you have one 
connected). You can also choose automatic gain control and test your recording device. 

Capture Device 

Select a camera that you want to use for video calls. Your external web cam is selected by 
default (if you have one connected). 

 

Video Size 

Select one of the available sizes. Note, however, that higher sizes require more bandwidth 
and a more capable central processing unit (CPU). 

 

15.3 Advanced 
 

Protocols 

If protocols are available to be viewed, they appear here. 
 

Device Management 

If the Device Management configuration URL is available to be viewed, it appears here. 
 

Select how to handle HTTP proxies. By default, the system settings are used but you can also 
choose not to use an HTTP proxy or to use UC-One proxy settings. 
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16 Call Settings 
 

 

UC-One supports the following service management features allowing supplementary 
services to be managed using the Preferences and Call Settings view available in the 
Main window left pane by selecting the appropriate sub-view in the drop down: 

 Incoming calls 

 Outgoing Calls 

 Voicemail 

 Services 
Incoming calls 

16.1 Do Not Disturb 

When you activate this service, all calls are typically blocked by the server and are sent to 
voice mail. Enable this service by enabling the service icon. 

 

16.2 Anonymous Call Rejection 
The Anonymous Call Rejection service allows you to reject calls from parties who have 
explicitly restricted their identities. 

You can enable or disable anonymous call rejection in the Preferences and Incoming 
Calls tab. 

 
16.3 Call Forwarding 

Enter a number to which your calls should be forwarded. Different variants of Call 
Forwarding are supported, such as forwarding always, forwarding when busy, and 
forwarding when you cannot answer or when you are unreachable. In addition, you can 
specify the number of rings before call forwarding is triggered. 

16.4 Simultaneous Ring  

Add up to 10 additional numbers or Session Initiation Protocol Uniform Resource Identifier 
(SIP-URI) addresses that you would like to ring in addition to your primary number when you 
receive a call. In addition, specify whether you want answer confirmations and if you would 
like to receive calls when already on another call. This service is an older variant of 
Anywhere. 
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16.5 Remote Office 
This service allows the use of any phone as the office phone from a charging and 
numbering perspective. For instance, a hotel room phone can be used as the office 
phone. 

Enable Remote Office by clicking the service icon and specifying a phone number to be 
used as the Remote Office number. 

 
16.6 Call Waiting 

The Call Waiting service allows you to answer a call while already engaged in another call. 

You can enable or disable server-based call waiting in the Preferences and Incoming Calls 

tab. If you disable Call Waiting, the second incoming call will not be connected and the 
caller hears an announcement that the call cannot be completed. 

 
16.7 Broadworks  Anywhere 

Broadworks Anywhere allows service providers to offer fixed-mobile convergence (FMC) 
services today without additional equipment. 

Broadworks  Anywhere simplifies communications for on-the-go users and remote users 
by extending the features of a desk phone to any other fixed or mobile device, 
regardless of the network or handset manufacturer. Callers dial one number and can 
reach you on any phone the user chooses. A desk phone, cell phone, and/or a soft 
phone may ring simultaneously. 

Experience voice call continuity with the ability to move live calls from one 
device to another without hanging up. 

Add locations (numbers) that can be used in the service via the Add Number field. Use 
the Alert all locations simultaneously check box to activate parallel ringing. Click on the 
“+” icon to see more options. 

Select Answer Confirmation to receive a separate audio prompt when answering a call 
from that number (location). It may be useful in cases where, for example, mobile 
numbers are being used to prevent incoming calls going to mobile voice mail since the 
call will be ended without going to voice mail if the answer confirmation is not provided. 
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Outgoing calls 
16.8 Automatic Callback 

The Automatic Callback (ACB) service allows you to be notified when the previously called 
busy party becomes idle and is connected without having to redial the phone number. 

When you call another party and the call cannot be connected because the line is busy, 
you are prompted to make an automatic callback request (for example, “The line you are 
calling is busy. Press 1 if you would like to be notified when the line becomes available”). 

If you select Automatic Callback, the system monitors the busy party and automatically 
establishes a call when the busy party becomes available. 

 
16.9 Block My Caller ID 

You can hide or display your number when calling or communicating with other parties or 
contacts. Hide your number by enabling the service icon. To show your number, set this to 
“Disable”. 

 

Voicemail 
16.10  Voice Messaging 

You can enable or disable voice messaging in the Preferences and Incoming Calls tab. A 
number of settings are available: 
16.10.1 Send all calls to voicemail. 

16.10.2 Send busy calls to voicemail. 

16.10.3 Send unanswered calls to voicemail. 

16.10.4 Specify how voice mail messages are handled using an indicator in UC-One 
or forwarding toe-mail. 

16.10.5 Enable notifications of new messages via email. 

16.10.6 E-mail a carbon copy of new voice mail. 

16.10.7 Transfer incoming calls to a specified number using “0” DTMF 

16.10.8 Specify how many rings are used before sending an incoming call to voice mail. 

16.10.9 Allow/ disallow callers to leave a message 
 

Services 
16.11 Hub 

You can enable or disable Hub as a whole. You cannot enable/disable individual micro-
apps within Hub. 

 
16.12 Start Meeting 

 

You can choose the default method of initiating a collaboration session. 
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NOTE: Closing the main window (not the Sign In window) does not exit the 
application but rather minimizes the application to the system tray (Dock). 
This allows you to continue to receive calls and messages without having the 
Contact List window appearing on the desktop. 

17 Sign Out 
 

 

Signing out of UC-One sets your status to “Offline” for your contacts and displays the 
Sign In screen. 

17.1 Sign Out of UC-One 

To sign out, follow these steps. 
 

Windows 

1) Click the UC-One logo in the main window title bar. 

2) Select Sign Out. 

OS X 

1) Select Actions from the main menu. 

2) Select Sign Out. 

17.2 Exit Application 

To exit the application completely, follow these steps. 
 

Windows and OS X 

Close the Sign In window. 

Windows 

1) Select the UC-One logo in the main window title bar. 

2) Click Exit. 
 

OS X 

1) Select UC-One from the main menu. 

2) Select Quit UC-One. 
 



PAGE 41 OF 44 

 

 

 
 

 

 

18 Multi-Device Support 
 

 

UC-One supports users with multiple devices, according to the CHAT specifications. This 
is comprised of several features: 

 Chat invitations sent to a user are received in all devices. Before the session is 
accepted, messages are sent to all devices and once answered, the chat messages 
go to the device that has sent a reply message. 

 One can retrieve one’s own presence notifications when another client updates the 
user’s presence. The client stores this information and updates its own presence so 
that it is the same as the higher priority status it received, (that is, when the received 
status update is manual). If the received presence update is not manual, it does not 
react to the received update; it only notes it. 

 Accepting a sharing presence invitation in one client is also recognized by another 
client, and both clients start receiving presence updates. 

 A new presence subscription made in one client is recognized in another. If the 
contact blocks the “invitation”, there are presence notifications from the server to all 
of the user’s clients that indicate that the subscription was terminated and this 
information is shown to the user. If the client receives two presence authorization 
requests from two or more devices for the same user, it only shows one request to 
the user. 

 Removing a contact from the contact list in one device is recognized in another client 
and the contact list is updated (that is, the contact is removed) in the other client as 
well. 

If a user has many devices, each device has the same status when shown to the end user. 
In addition, the contacts on the contact list always see the same status with updates 
shown in the following priority order: 

 Busy 

 Online 

 Away 

 Offline 

This means, for example, that if one client publishes a Busy status and another client 
publishes another status, contacts see the user as Busy. Compatible devices such as desk 
phones are able to show presence in the same way. 
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19 System Requirements 
 

 

System requirements are as follows on native desktop: 

 Operating system(s): 
• Windows: Windows 7, Windows 8/8.1, or Windows 10 (Classical view 

only). 

• Macintosh: Mac OS 10.10 Yosemite, Mac OS 10.11 El Capitan, Mac 
OS 10.12 Sierra 

 The installation footprint is approximately: 

• 215 MB on Windows 

• 125 MB on OS X 

 For voice calls, a sound card, speakers, and a microphone or a headset are 
required. 

 For video calls, a web cam is required. 

 
Minimum system requirements for respective operating systems need to be fulfilled, 
with the following additions: 

 A minimum of 2 GB random access memory (RAM) is required. 

 A minimum 1.5 GHz CPU is recommended. A dual core CPU is recommended 
for video calls at aminimum. 

 Open Graphics Library (OpenGL) 1.5 or higher is recommended. 

 
For high definition (HD) video, the following is recommended: 

 HD camera 

 HD resolution support in display 

 Quad Core x86 or equivalent at a minimum 

 4 GB RAM 
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20 Troubleshooting 
 

 

Why can’t I chat with contacts from Google? 

Chatting with users in other domains is possible, but a 3rd party XMPP gateway service must 
be utilized to connect 2 corporate applications such as Google and Skype for Business. 
Evolve IP does not offer CHAT gateway services. 

 
Why can’t I change the avatar? 

Double-clicking the avatar should open a File Explorer view to select a file. If your CHAT 
connection is lost, changing the avatar does not succeed. A lost CHAT connection is 
indicated in the main window’s top notification area. 

 
My contacts are all offline and my client’s status bar says “CHAT unavailable”. What does this 
mean? 

It means that the CHAT connectivity has been lost for chat, as well as for presence; however, 
you can still make calls. You should contact your group Administrator. 

 
Why am I offline? 

If you have selected “Offline” status, you are shown as offline to others. Another possibility is 
that you may have lost your Internet connection. In this case, the client does not log out, but 
rather enters an offline mode where a contact list is available but communication is not 
possible. 

 
Why can’t I have more video resolutions available? 

You can choose your video resolution from Preferences and the Video tab. Your selection is 
used by default for future video calls. The available resolutions are automatically presented 
based on your camera. 

 
Why can’t I change my user name and password? 

User name and password editing is not supported in the client. To edit your user name or 
password, contact your group Administrator. 

Why does my all day calendar entry not trigger Busy – In Meeting presence status? 

All day meetings do not trigger a presence change to Busy – In Meeting. 

To trigger the presence update, the meeting must be self-generated or accepted (tentative or 
fully accepted). The presence update is only triggered by appointments and meetings that 
are either accepted by the user or made by them. 

 
Why aren’t all my group chat messages saved? 

Only the newest chat room messages are stored on the server. 
 

Why aren’t all my chat messages available in my other devices? 

All 1-1 chat messages are saved, but only locally, so they are not necessarily available in your 
other devices. Incoming messages are sent to all devices; however, the ones that you send 
are only stored in the device that you are using to send the message. 

 
Why can’t I change the CHAT address of a contact? 

This is not supported in this release. 



PAGE 44 OF 44 

 

 

Why does my location show an incorrect address? 

It is done based on the public IP address that the machine is using. The IP address is mapped 
to a physical location. You can also manually change the location by clicking the avatar and 
changing the location icon. 

 
Why can’t I start desktop sharing? 

To share your desktop, you need to have valid credentials, which are automated by Evolve IP. 
Contact your group Administrator. 

 
Why can’t My Room participants share the desktop? 

Only the owner of the room can share the desktop. This applies to both My Room and ad hoc 
sessions. 

How long are my chat messages stored? 
Chat messages are currently stored locally on the PC, so its dependent on the life of the 
PC. For example, I have chats as old as the beginning of last year when I look back at my 
chat history. But if my PC is rebuilt, or the client re-installed, I would only have chat 
history to that date. 

 
How can I shutoff the incoming call notification on my desktop for UC-One? 
From the UC-One application, a user can shutoff the incoming call notification by dialing 
a Feature Access Code *13 to deactivate the incoming call notifications. If they would 
like to reactivate, dial *12 from the application. 

 
What is the largest sized file I can share with other users through UC-One? 
Users are able to share equal or less than 15MB in size. 

 
How are updates rolled out to the organization? 
When Evolve IP is ready to push out an update, the users get a message on their next 
login to update their application. Some updates are required. Notifications will reflect 
this requirement. 

 
Is the application installed locally or web-based? 
Locally. 

 
Will I be able to see who is on a phone call if they do not have the UC-One application? 
No. The more people using the application, the more robust it is. Competitor 
applications work in this same fashion (ex. Skype for Business) 

 
Can I install the application on more than 1 machine? 
Yes. It is recommended to only login to the application from one machine at a time 
though, unless it’s the PC and mobile app at the same time. 

 
How many simultaneous viewers can you share your desktop with? 
Max amount allowed is 8. This is including yourself + 7 viewers. 
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